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Open your Virtual Machines

1. Turn on your Laptops

2. Login to Windows using “User”

3. Open the Virtual Box program

4. Select the nRF52840LAB Virtual Machine & click Start

5. Log-in using credentials:

6. Open Visual Studio Code (use the App bar on the left)

Username: ubuntu

Password: ubuntu
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Open the week16 folder in the terminal

Right click on the left + “Open in Integrated terminal”

From the Terminal:
make setup

Prepare the Coding Environment
1

3

2

4

If you see any (yellow) errors input the credentials again
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Recap: Data Types

C has a number of primitive data types:

int

float

char

bool

Strings are NOT a primitive data type, and have special syntax.

strings

42

‘A’

true

1200 1_200

3.14 0.00001

‘@’

false

‘\n’

-3

-2.1

"Hello" "A" "I am a full sentence!"
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Recap: Variables
A variable is a named container that stores data or values.

Booleans require a custom include statement:

int x = 42;

float y = -0.12;

char w = 'A';

char z[50] = "Full sentence";

#include <stdbool.h>

bool hello = true;
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Recap: Boolean Operators
>

>=

<

<=

==

!=

!

Greater than
Greater or equal than

Less than
Less or equal than

Equals
Not equals

Not
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Recap: Chaining Comparisons

● and (both must be true)

● or (either must be true)

● not (negation)

!true !(5 < 3)

true && false (5 < 6) && (5 < 10)

true || false (5 < 3) || (5 < 10)
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Recap: If-Statement chaining

You can chain multiple conditions with else if.

What is the difference between these two snippets of code?
int num;

scanf("%d", &num);

if (num < 3) {

printf("Small number\n");

} else if (num < 10) {

printf("Medium number\n");

}

int num;

scanf("%d", &num);

if (num < 3) {

printf("Small number\n");

}

if (num < 10) {

printf("Medium number\n");

}
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Recap: While-Loops

Repeat parts of 

your code!

int num;

printf("Input a number greater than 100: ");

scanf("%d", &num);

while (num <= 100) {

printf("Wrong number, try again: ");

scanf("%d", &num);

}

printf("Well done!\n");
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Recap: For-Loops

Repeat a specific amount of times!

int x = 0;

while (x < 5) {

x += 1;

printf("Hello %d\n", x);

}

int x;

for (x = 1; x <= 5; x++) {

printf("Hello %d\n", x);

}
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Recap: Arrays

Modifiable containers for data.

With variables:                            With a list:
int num1 = 42;

int num2 = 100;

int num3 = 10;

printf("%d\n", num1);

printf("%d\n", num2);

printf("%d\n", num3);

int array[] = {42, 100, 

10};

for(int i = 0; i < 3; i++) 

{

   printf("%d\n", 

array[i]);

}
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Recap: Accessing Array Elements

To access array elements you can use the [index] operator.

NOTE: List indices start from 0

                  index:                 0     1     2     3     4

                  

int array[] = {17, 28, 33, 56, 6};

printf("%d\n", array[0]); printf("%d\n", array[3]);
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Recap: What is the nRF52840?

USB Port

RGB LED

Reset 
Button

Programmable 
Button
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Recap: The LED Library
#define RGB_LED_RED     1

#define RGB_LED_GREEN   2

#define RGB_LED_BLUE    4

#define RGB_LED_MAGENTA (RGB_LED_RED | RGB_LED_BLUE)

#define RGB_LED_YELLOW  (RGB_LED_RED | RGB_LED_GREEN)

#define RGB_LED_CYAN    (RGB_LED_GREEN | RGB_LED_BLUE )

#define RGB_LED_WHITE   (RGB_LED_RED | RGB_LED_GREEN | RGB_LED_BLUE)

/*----------------------------------------------------------------*/

void rgb_led_off(void);

void rgb_led_set(uint8_t colour);
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Recap: The E-Timer Library
/* Event generated when a timer expires */

#define PROCESS_EVENT_TIMER           0x88

/*----------------------------------------------------------------*/

/* Set the amount of time on the timer. Also start the timer */

void etimer_set(struct etimer *et, clock_time_t interval);

/* Restart the timer with the previously set amount of time */

void etimer_restart(struct etimer *et);

void etimer_stop(struct etimer *et);

/*----------------------------------------------------------------*/

/* Check if the timer has completed */

bool etimer_expired(struct etimer *et)
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Recap: Using an E-Timer
#define BLINK_INTERVAL (0.2 * CLOCK_SECOND)

static struct etimer blink_timer;

PROCESS_THREAD(demo_process, ev, data) {

  PROCESS_BEGIN();

  etimer_set(&blink_timer, BLINK_INTERVAL);

  while (true) {

    PROCESS_WAIT_EVENT();

    if (etimer_expired(&blink_timer)) {

      etimer_reset(&blink_timer);

      // Do something on timer expiry

    }

  }

  PROCESS_END();

}

3
4

2

1
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Recap: Networking Packets

● Networking involves transmitting data over a medium.

● Information is transmitted in packets: small chunks of data 

(of arbitrary length) sent over the network.

Coding

DATA
DATA
DATA
DATA
DATA
DATA

PA
CK

ET
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Recap: Disambiguating Packets
typedef struct {

 char team_id;

 int command;

 int data;

} message_t;

// IMPORTANT!

// Change the `TEAM_ID`!

#define TEAM_ID 'Z'

To know where packets are 
coming from we add a team_id 
field to packets.

To use this field in the next 
exercise you MUST set the 
TEAM_ID macro at the top of 
the file.
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Recap: Receiving Packets
/* Helper function to receive data over nullnet */

void receive_nullnet_data (

 const void *bytes,

 uint16_t len,

 const linkaddr_t *src,

 const linkaddr_t *dest)

{

 int data;

 memcpy(&data, bytes, len);

 printf("Data received: %d\n", data);

}

We provide a helper 
function to simplify 
receiving packets over 
nullnet:

receive_nullnet_data

You can add functionality 
inside the function 
body.
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Recap: Sending Packets
/* Helper function to send data over nullnet */

void send_nullnet_data (int data) {

 printf("Sending data: %d\n", data);

 nullnet_buf = (uint8_t *)&data;

 nullnet_len = sizeof(data);

 NETSTACK_NETWORK .output(NULL);

}

send_nullnet_data (200);

variable = 42;

send_nullnet_data (variable);

We provide a helper 
function to simplify 
sending packets over 
nullnet:

send_nullnet_data

You can call this function 
but you should NOT edit 
it.
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Recap: Header Files
#ifndef CONFIG_H

#define CONFIG_H

/* Message Configuration */

typedef struct

{

   char team_id;

   int data;

} message_t;

#define TEAM_ID 'Z'

#endif // CONFIG_H

Header files allow you to define types, 
structures, or common code once and 
reuse it in multiple source files

#include "config.h"

printf("Team ID: %c", TEAM_ID);

config.h

file.c
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Recap: Cooja

From the Terminal run the make cooja command:
make cooja

1

Cooja is a Simulator for the Contiki-NG Operating System.

It allows for Contiki-NG programs to be compiled and executed 
on virtual simulated test-beds. 

The simulated motes will behave similarly to the real world.
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Recap: Adding a Cooja Mote
Let’s add a new Mote:

Motes > Add motes > Create new > Cooja mote

1
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Recap: Adding a Cooja Mote
Put “Sender” in the description2

Use the firmware under (you can also use “Browse”):
/home/ubuntu/Documents/valsalice-iot-23/lab/week14/simple/sender.c

3

Click “Compile”4

Click “Create”5
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Recap: Adding a Cooja Mote
Put “1” in the “Number of new motes” field6

Click “Add motes”7

You should get this8
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Recap: Adding a Cooja Mote
After you create the Mote it will be available for quick 

access in the simulation:

9

Simply click on the Mote name to create new motes of 

that type

10
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Recap: Opening a Cooja Simulation
Open an existing Cooja Simulation

File > Open simulation > Browse…
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Recap: Recompiling Mote Code
To recompile motes you simply reload the simulation

Simulation > Reload Simulation > Same seed

SHORTCUT: You can simply press Ctrl + R

   Errors will be raised:
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Node IDs

Node IDs are unique IDs assigned to each physical chip. They 
allow us to identify each chip when it sends or receives 
messages.

Cooja additionally simulates IDs assigning them to the nodes.

#include "sys/node-id.h"

printf("Node ID: %d\n", node_id);
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Logging

Rather than using prints to facilitate visualising information on 
serial output we use a “logger”.

Fundamentally any time we would use printf we can now use 
LOG_INFO, there is no other difference.

#include "sys/node-id.h"

printf("Node ID: %d\n", node_id);

LOG_INFO("Node ID: %d\n", node_id);
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Exercise

Open the following Cooja simulation:
             week16/nodes/topology1.csc

Implement in week16/nodes:

1) Hello (hello.c):
     // TODO: Print the Node ID

Add multiple nodes to the simulation →

Change the TEAM_ID in config.h!

hello.c
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Exercise Solution (hello.c)

         if (etimer_expired(&periodic_timer))

           {    

                 // TODO: Print the Node ID

                 LOG_INFO("Node ID: %d\n", node_id);

                 etimer_reset(&periodic_timer);

           }
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      1) Flash the hello firmware to real hardware:

      
      2) Log into the mote, what do you see?

Test that it works

make hello.dfu-upload

make login

Open a new terminal in  week16/nodes
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Save remotely your Changes
make save1

2

3
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Leveraging Node IDs
#ifndef CONFIG_H

#define CONFIG_H

/* Message Configuration */

typedef struct

{

   char team_id;

   int node_id;

} message_t;

#endif // CONFIG_H

We will begging using Node IDs to 
know where are coming from:

● team_id is for team membership
● node_id tracks packet origin

#include "config.h"

char tid = message.team_id;

int nid = message.node_id;

printf("node_id '%d', team'%c'\n", nid, tid);

config.h

file.c
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Exercise

Open the following Cooja simulation:
             week16/chat/topology2.csc

Implement in week16/chat:

1) Sender (sender.c):
     // TODO: Send an empty message

2) Receiver (receiver.c):
     // TODO: Change `false` to check for `TEAM_ID`
     // TODO: Print the node ID the message is coming from

Change the TEAM_ID in config.h!

sender.c

receiver.c
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Exercise Solution (sender.c)

         if (etimer_expired(&periodic_timer))

           {

                 // Periodically send an empty message

                 send_nullnet_data();

                 etimer_reset(&blink_timer);

                 etimer_reset(&periodic_timer);

           }
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Exercise Solution (receiver.c)

 if (msg_team_id == TEAM_ID)

 {

   // Turn the LED on ONLY IF we receive data

   leds_single_on(LEDS_LED1);

   LOG_INFO("Got message from node_id: %d\n", msg_node_id);

 }
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      1) Flash the sender firmware:

      2) Move the sender mote to a different machine!

      3) Flash the receiver firmware and make login:

Test that it works

make sender.dfu-upload

make login

Open a new terminal in  week16/chat

make receiver.dfu-upload
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Save remotely your Changes
make save1

2

3
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Change to Message Configuration
#ifndef CONFIG_H

#define CONFIG_H

/* Message Configuration */

typedef struct

{

   char team_id;

   int node_id;

   int data;

} message_t;

#endif // CONFIG_H

We are changing the message_t struct 
to now also be able to disseminate 
data together with each packet

● team_id is for team membership
● node_id tracks packet origin
● data payload of each packet

config.h
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Exercise

Open the following Cooja simulation:
         week16/counting/topology3.csc

Implement in week16/counting:

1) Node (node.c):
   // TODO: If sender is node 1 and I am node 2: reply
   // TODO: If sender is node 2 and I am node 3: reply
   // TODO: If sender is node 3 and I am node 1: reply

Change the TEAM_ID in config.h!

node.c
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Exercise Solution (node.c)
     if (msg_team_id == TEAM_ID)

     {

           // Turn the LED on ONLY IF we receive data

           leds_single_on(LEDS_LED1);

           if (msg_node_id == 1 && node_id == 2) {

                 send_nullnet_data(msg_data + 1);

           } else if (msg_node_id == 2 && node_id == 3) {

                 send_nullnet_data(msg_data + 1);

           } else if (msg_node_id == 3 && node_id == 1) {

                 send_nullnet_data(msg_data + 1);

           }

     }
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    1) Flash the hello firmware to get the IDs of the nodes:

      Open a new terminal in  week16/counting

      2) Change your node.c code to use the new IDs:

      3) Flash the node firmware on ALL motes and make login:

Test that it works

make hello.dfu-upload

make login

Open a new terminal in  week16/hello

make node.dfu-upload
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Save remotely your Changes
make save1

2

3



School Year 2023-2024Introduction to IoTAlberto Spina

End of Class

See you all next week!


